Introduction to Firewall and Firewall Configuration

Course: CS56315 Mobile Systems Security
Lecturer: Simon Foley

William Fitzgerald
Cork Constraint Computation Centre,
Department of Computer Science,
University College Cork,
Ireland.
Web: www.williamfitzgerald.net

Email: wfitzgerald@4c.ucc.ie

February, 2010

William Fitzgerald, CS6315, Feb. 2010. 1/ 31



OSI Network Layer Stack

D> Prerequisite OSI model TCP/IP model | Common Packet Attributes Filtered
The Firewall —— —— —— .
Firzwalﬁewa Application Application Application Protocol Pattern Matching
Configuration Presentation
packet Filter Session TCP/UDP TCP & UDP protocol,
Stateful Firewall Transport TCP & UDP ports, TCP Flags
Application-Layer Network IP, ICMP source & destination IP, ICMP Type
E're""a” Data Link Data link source MAC address

roxy : -
Summary Physical Physical
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RFC791:

IPv4 Protocol Header

> Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary
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RFC793:

TCP Protocol Header

> Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary
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RFC793: TCP Handshaking

> Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Connection setup (3-way Handshake):

1. Initiator sends SYN
2. Recipient sends SYN/ACK
3. Initiator sends ACK

Connection Tear-down (4-way Handshake):

1. Initiator sends FIN/ACK
2. Recipient sends ACK

3. Recipient sends FIN/ACK
4. Initiator sends ACK

Note: A TCP connection is full duplex (that is, data can flow independently in each direction), therefore each

direction must be terminated independently.
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Firewall Definition

Prerequisite

> The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

One of the earliest definitions of a firewall [Cheswick] is
“a collection of components placed between two networks that
collectively have the following properties:

1. All traffic from inside to outside, and vice-versa, must pass
through the firewall.

2. Only authorized traffic, as defined by the local security
policy, will be allowed to pass.

3. The firewall itself is immune to penetration.”

[Cheswick] William R. Cheswick and Steven M. Bellovin: Firewall and Internet Security: Repelling the Wily
Hacker, Addison-Wesley, April 1994.
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Firewall Definition

Prerequisite

> The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Refining properties 1 and 2 in the definition provided by
[Cheswick], we provide the following definition:

A firewall is a security system that controls traffic flow to and
from network resources which are hosted by a local firewall
system or hosted by a network of systems behind a network-wide
firewall in accordance with a security policy.
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Definition: Security Policy

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

A Security Policy is a high-level policy document that defines a
“set of rules and practices that specify or regulate how a system
or organization provides security services to protect sensitive and
critical system resources” [RFC2828|.

O Purpose of a security policy is to ensure that the high-level
security requirements are upheld.
O However, it is not intended to prescribe specific firewall rules.

O The security policy is further refined into a network security
policy.
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Example: Security Policy

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

Example fragment of a Payment Card Industry Data Security

Standard (PCI-DSS) security policy recommendation.

Objective: Build and Maintain a Secure Network

Requirement ID | Requirement
reg-1 Install and maintain a firewall configuration to protect cardholder
data.
req-1.2 Build a firewall configuration that restricts con-

nections between untrusted networks and any sys-
tem components in the cardholder data environ-
ment.

req-1.2.1 Restrict inbound and outbound traffic to
that which is necessary for the cardholder
data environment.
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Definition: Network Security Policy

iLerqu_“‘S‘te” A Network Security Policy describes an organisation’s network

€ rirewa

 Frevall security concerns when providing access internally and externally
ontiguration )

Packet-Filter to its network resources.

Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

Summary
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Example:

Network Security Policy

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

Example network security policy derived from the security policy:
Policy ID Description
nsp-1 Permit Internet access to Web server on ports HTTP and HTTPS.
nsp-2 Permit business partners access to Extranet partner server over port VPN.
nsp-3 Permit Intranet users access to external Web servers on ports HTTP and HTTPS.
nsp-4 Permit Intranet users access to file server on port FTP only.
nsp-5 Permit firewall administration from Intranet on port SSH by administrator team.
nsp-6 Deny Skype communication.
nsp-7 Deny known Remote Access Trojans making outward connections.
nsp-8 Log and Deny all other Internet to Intranet access.
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Definition:

Firewall Configuration

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

A firewall configuration implements a network security policy and

is defined by a sequence of firewall rules against which all
packets traversing the firewall are filtered.
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Example:

Firewall Configuration

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

Linux Netfilter Firewall Configuration

iptables -A FORWARD -i ethO -d webIP -dport 80 -j ACCEPT
iptables -A FORWARD -o ethl -s webIP -sport 80 -j ACCEPT
iptables -A FORWARD -j DROP
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Example: Firewall Configuration

Prerequisite

The Firewall
Firewall
D> Configuration

Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy
Summary

A firewall configuration derived from the network security policy.

Security Policy Network Security Policy
|
req-1 2 nsp-1 |
req-1.1
req-1.1.1 | nsp-2 |
reg-1.2 | nsp-3 |
| req-1.2.1 I
req-1.4 .
req-12
9 | nsp-8
Y
Linux Netfilter Firewall Configuration
iptables -A FORWARD -i ethO -d webIP -dport 80 -j ACCEPT
iptables -A FORWARD -o ethl -s webIP -sport 80 -j ACCEPT
iptables -A FORWARD -j DROP
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Firewall Rules

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Each firewall rule takes the form of a series of conditions on
packet fields that must be met in order for that rule to be
applicable, with a consequent action for the matching packet.

Firewall
Stateful Firewall Column Name Description OSI Layer Filtered
A.ppllcatlon—Layer Index Rule position in firewall configuration. -
el Dir Packet direction: inbound or outbound. -
Proxy Iface Network interface on which a packet was received. Physical
Summary Mac Source MAC address. Data Link
Src IP Source IP address. Network
Dst IP Destination IP address. Network
ICMP-Type ICMP Type. Network
ICMP-Code ICMP Code. Network
Proto Protocol. Transport
Src Port Source port. Transport
Dst Port Destination port. Transport
Flag TCP Flags Transport
L7-filter Packet payload pattern match. Specific to Netfilter Application
Action Action to perform on the packet: allow, deny and log -
Index Dir Iface Proto Src IP Dst IP Src Port Dst Port L7-filter Action
1 out ethl udp 192.168.1.* KRR K 33033 * skypeout Deny
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Default Firewall Configuration Policy

Prerequisite

The Firewall
Firewall

D> Configuration

Packet-Filter

Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

Rules are tested in the order in which they appear in the table.

Once a packet has been successfully matched against a rule, no
further rule tests are carried out for that packet.

If the packet fails to be matched against any of the rules, then
the firewall imposes a default policy/rule which can be either:

O Default Deny: everything is denied except that which is
explicitly permitted.

O Default Allow: everything is permitted except that which is
explicitly denied.
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Packet-Filter Firewall

Prerequisite
The Firewall
Firewall
Configuration

Packet-Filter
> Firewall

Stateful Firewall

A packet-filter is a firewall that makes decisions about whether
or not to permit a packet based only on information found at the
data-link, network or transport layers.

Application-Layer OSI| model TCP/IP model Common Packet Attributes Filtered
:r;\:;a” Application Application Application Protocol Pattern Matching
Slmmary Presentation

Session TCP/UDP TCP & UDP protocol,

Transport TCP & UDP ports, TCP Flags

Network IP, ICMP source & destination IP, ICMP Type

Data Link Data link source MAC address

Physical Physical

William Fitzgerald, CS6315, Feb. 2010. 15 / 31



Packet-Filter Firewall

Prerequisite
The Firewall
Firewall
Configuration

Packet-Filter
> Firewall

Stateful Firewall
Application-Layer

Modern packet-filters have the ability to specify firewall rules
based on which physical network interface a packet is received or
Is destined to be transmitted from.

Firewalls typically have multiple inbound and outbound network

Firewall
Prox I f
4 Interraces.
Summary
Index Dir Iface Proto SrcIP Src Port DstIP Dst Port Flag Action s -
- in | @0 | tp | **F* | > 1024 | weblP 80 * Allow | Index | (?L'JI | ';ahcf | Poto | Sclp | ScPort | DEIP | Do Port | Fiag | ﬁff';; |
T L > To24 | weip | 443 Allow | [ ot | ant | IREEEN IREEEN [~ | |
g eth1
=
ethO| i
0]
= |eth2
H
- [}
etha]
& [an3
[ Index | Dir [ Iface [ Proto [ SrcIP [ SrcPort | DstIP | DstPort | Flag | Action |
[ - [in [ ehd | tcp [ patnerlP [ >1024 | vpniP | 22 * | Allow |
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Packet-Filter Firewall

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Packet-filters are stateless, meaning that each packet is
examined in isolation of previously examined packets.

pktl=[srclP:anylP,dstIP:weblP,dstPort:80,tcpFlag:SYN] E) E_pkﬂ:[srclP:weblP,dstlP:anylP,srcPort:80,tch|ag:ACK]

Stateless Packet-Filter Firewall

Packet-Filter does not take advantage of the semantic relationship between these two packets.
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Example:

Packet-Filter Configuration

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Consider the following network security policy:

Policy ID Description
nsp-1 Permit Internet access to Web server on ports HTTP and HTTPS.
nsp-2 Permit business partners access to Intranet partner server over port VPN.
nsp-3 Permit Intranet users access to external Web servers on ports HTTP and HTTPS.
nsp-4 Permit Intranet users access to file server on port FTP only.
nsp-5 Permit firewall administration from Intranet on port SSH by administrator team.
nsp-6 Deny Skype communication.
nsp-7 Deny known Remote Access Trojans making outward connections.
nsp-8 Log and Deny all other Internet to Intranet access.
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Example:

Packet-Filter Configuration

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Consider the following network security policy:

Policy ID Description
nsp-1 Permit Internet access to Web server on ports HTTP and HTTPS.
nsp-2 Permit business partners access to Intranet partner server over port VPN.
nsp-3 Permit Intranet users access to external Web servers on ports HTTP and HTTPS.
nsp-4 Permit Intranet users access to file server on port FTP only.
nsp-5 Permit firewall administration from Intranet on port SSH by administrator team.
nsp-6 Deny Skype communication.
nsp-7 Deny known Remote Access Trojans making outward connections.
nsp-8 Log and Deny all other Internet to Intranet access.

The following firewall rule-set is an example implementation:

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp kKR x > 1024 weblP 80 * Allow
2 in eth0 tcp kKX > 1024 webIP 443 * Allow
3 in ethO tcp partner|P > 1024 vpnlP 22 * Allow
4 in eth0 tcp KKk 80 lanlP > 1024 ack Allow
5 in ethl tcp lanlP > 1024 ftplP 21 * Allow
6 in ethl tcp adminlP > 1024 fwlP 22 * Allow
7 in eth0 udp KRR X * lanIP 23399 * Deny
8 in eth0 * KKk * Rk K * * Log
9 in eth0 * KRR X * KOk xR K * * Deny
10 out eth0 tcp lanlP > 1024 * Kk K 31337 * Deny
11 out eth0 udp lanlP > 1024 Rk K 31337 * Deny
12 out ethl * KRR X * KOk xR K * * Allow
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Example:

Packet-Filter Configuration

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Policy ID Description
nsp-1 Permit Internet access to Web server on ports HTTP and HTTPS only.
nsp-2 Permit business partners access to Intranet partner server over port VPN.
nsp-3 Permit Intranet users access to external Web servers on ports HTTP and HTTPS.
nsp-4 Permit Intranet users access to file server on port FTP only.
nsp-5 Permit firewall administration from Intranet on port SSH by administrator team.
nsp-6 Deny Skype communication.
nsp-7 Deny known Remote Access Trojans making outward connections.
nsp-8 Log and Deny all other Internet to Intranet access.

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp kKR X > 1024 weblP 80 * Allow
2 in eth0 tcp KRR > 1024 weblP 443 * Allow
3 in ethO tcp partnerl|P > 1024 vpnlP 22 Allow
4 in eth0 tcp KKk 80 lanlP > 1024 ack Allow
5 in ethl tcp lanlP > 1024 ftplP 21 * Allow
6 in ethl tcp adminlP > 1024 fwlP 22 * Allow
7 in eth0 udp KRR X * lanIP 23399 * Deny
8 in eth0 * kKR x * * Kk K * * Log
9 in eth0 * KKk * KRk K * * Deny
10 out eth0 tcp lanIP > 1024 * Kk K 31337 * Deny
11 out eth0 udp lanlP > 1024 Rk K 31337 * Deny
12 out ethl * kK K X * * K K X * * Allow
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Example:

Packet-Filter Configuration

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Policy ID Description
nsp-1 Permit Internet access to Web server on ports HTTP and HTTPS only.
nsp-2 Permit business partners access to Intranet partner server over port VPN.
nsp-3 Permit Intranet users access to external Web servers on ports HTTP and HTTPS.
nsp-4 Permit Intranet users access to file server on port FTP only.
nsp-5 Permit firewall administration from Intranet on port SSH by administrator team.
nsp-6 Deny Skype communication.
nsp-7 Deny known Remote Access Trojans making outward connections.
nsp-8 Log and Deny all other Internet to Intranet access.

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp kKR x > 1024 weblP 80 * Allow
2 in eth0 tcp KRR > 1024 weblP 443 * Allow
3 in ethO tcp partnerl|P > 1024 vpnlP 22 Allow
4 in eth0 tcp KKk 80 lanlP > 1024 ack Allow
5 in ethl tcp lanlP > 1024 ftplP 21 * Allow
6 in ethl tcp adminlP > 1024 fwlP 22 * Allow
7 in eth0 udp KRR K * lanIP 23399 * Deny
8 in eth0 * kKR x * * Kk K * * Log
9 in eth0 * KKk * KRk K * * Deny
10 out eth0 tcp lanIP > 1024 * Kk K 31337 * Deny
11 out eth0 udp lanlP > 1024 Rk K 31337 * Deny
12 out ethl * * Ok kX * KKk K * * Allow
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Example: Port-Based Attack Reduction

Prerequisite

The Firewall

Firewall

Configuration
Packet-Filter

> Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

An attack surface is the number of Internet accessible network
resources (in terms of IP addresses and ports) that are available
for a potential attacker to exploit.

O A Web server may have a number of open ports, for example
telnet, that are not intended for Internet access.

65535

T

3

=

g http
[F (I
(& —C) | 5 @ https

X

8 @ tenet

g Web Server

D

w

0]

0

Restrict what services (ports) are accessible
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Example: Port-Based Attack Reduction

Prerequisite

The Firewall
Firewall

Configuration
Packet-Filter

> Firewall

Stateful Firewall
Application-Layer

O Configuring a packet-filter firewall to permit intended Web
server traffic destined for ports 80 and 443, will reduce the
attack surface from a possible 65535 ports to just 2 ports.

Firewall 65535
Proxy —
Summary g
'IE
g http
[ F oL
— ] 3 ® nitps
x
8 telnet
8 Web Server
©
o
n
0
Restrict what services (ports) are accessible
Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp kKX > 1024 weblP 80 * Allow
2 in eth0 tcp kR R x > 1024 weblP 443 * Allow
William Fitzgerald, CS6315, Feb. 2010. 17 / 31




Example:

Port-Based Attack Reduction

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

—— pktl=[srcIP:anylP,dstIP:weblP,dstPort:80] —3»

— pkt2=[srclP:anylP,dstIP:weblP,dstPort:443] -

4 — pkt3=[srclP:attacker|P,dstIP:weblP,dstPort:23] »--

Deny
|ﬁ|— pktd=[srcIP:partner|P,dstIP:vpnIP,dstPort:22] —3»-
E]— pktb=[srcIP:anylP,dstIP:vpnIP dstPort:22] —3»-

@ = Internet

| — Business partner

= Intentional Internet User

Stateless Packet-Filter Firewall

P

—

- <— pkt6=[srcIP:ftplP,dstIP:attackerlP,dstPort:31337] —

Allow

I
Allow

@ http
>@ https
>@® telnet

e

Deny

Web Server

—@ trojan

Allow

@ ftp
FTP Server

\

>@

= Accidental Internet User or Intentional Hacker

Deny

ssh

VPN Server
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Example: Client Access Restriction

Prerequisite
The Firewall
Firewall
Configuration

Packet-Filter
> Firewall

Stateful Firewall
Application-Layer
Firewall

Recall the network security goal:

Policy ID

Description

nsp-2

Permit business partners access to Intranet partner server over port VPN only.

Configured with the following firewall rule:

Proxy Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
3 in ethO tcp partner|P > 1024 vpnlP 22 * Allow
Summary
William Fitzgerald, CS6315, Feb. 2010. 18 / 31



Example: Client Access Restriction

Prerequisite

. htt
'Il'if;:W?lrlewall E]— pkt1=[srcIP:anylP,dstIP:weblP,dstPort:80] —» : Allow ® P
) . — https
Configuration ‘;“ Allow _’/?. P
Packet-Filter @— pkt2=[srcIP:anylP,dstIP:weblP,dstPort:443] —3»- g //”- /?. telnet
> Firewall L Deny \ )
o p -
State_fU| _Flrewa” E]— pkt3=[srcIP:attacker|P,dstIP:weblP,dstPort:23] - B / Web Server
Application-Layer E
Firewall i ;
HES Deny | 45 | <€— pkt6=[srcIP:fipIP dstlP:attackerlP dstPort:31337] ——@) trojan
Proxy ~
O
Summary Drg ® ftp
Iil— pkt4=|[srclP:partner|P,dstIP:vpnlP,dstPort:22] —3»- % - FTP Server
(D) \
O Allow
4(_'“ \
2 | Den
& y >@ ssh
VPN Server

@ = Internet —

(]
W = Business partner

= Accidental Internet User or Intentional Hacker

= Intentional Internet User
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Example: Malware Control

Prerequisite
The Firewall
Firewall
Configuration

Packet-Filter
> Firewall

Stateful Firewall
Application-Layer

Control of Malware can be applied to both inbound traffic (for
example, IRC channels which are often used to control zombie
networks) and to outbound traffic, normally considered trusted.

0 Well known Remote Access Trojans (RAT's) such as

Erewa“ Back-Orifice, can be blocked in terms of protocol and ports
roxy e . . .
Summary from indiscriminately making outbound connections to an

external command control.

Recall rules 10 & 11:

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
10 out ethl tcp lanIP > 1024 * kR X 31337 * Deny
11 out ethl udp lanlP > 1024 KRR 31337 * Deny

Remember, traffic is bidirectional. Mitigating the outgoing traffic will
prevent and established communication channel being constructed.
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Example:

Malware Control

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
> Firewall
Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

E]— pktl=[srcIP:anylP,dstIP:weblP,dstPort:80] —» -

@— pkt2=[srcIP:anylP,dstIP:weblP,dstPort:443] —3»-

E]— pkt3=[srcIP:attacker|P,dstIP:weblP,dstPort:23] -

Deny

|ﬁ|— pktd=[srcIP:partner|P,dstIP:vpnIP,dstPort:22] —3»-

H

@ = Internet

| — Business partner

= Intentional Internet User

pkt5=[srcIP:anylIP,dstIP:vpnIP,dstPort:22] —»-

Stateless Packet-Filter Firewall

I
-

- «— pkt6=[srcIP:ftplP,dstIP:attackerlP,dstPort:31337] —

Allow

Allow

Deny

Allow

@® http

P

>@ https
>@® telnet

I

Web Server

—@ trojan

@ ftp

FTP Server

\

>@

ssh

= Accidental Internet User or Intentional Hacker

Deny

VPN Server
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Example: Malware Control

Prerequisite

The Firewall

Firewall

Configuration
Packet-Filter

> Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

It is considered best-practice to avoid once-off firefighting rules

and to adopt a default deny rule on outbound traffic.

As a consequence, one must explicitly define a set of outbound
rules to complete the bi-directional communication requirements
of previously permitted inbound traffic.

0 Rules Rule 10, Rule 11 and Rule 12 are replaced with rules

that explicitly state what (trusted) traffic is permitted

outbound.
Index Dir Iface Proto Src IP Src Port Dst IP Dst Port la Action
- out ethl tcp weblP 80 KRR K > 1024 * Allow
- out ethl tcp weblP 443 * Kk K > 1024 * Allow
- out ethl tcp vpnlP 22 partnerlP > 1024 * Allow
- out ethl tcp lanIP > 1024 * Kk K 80 * Allow
- out ethl tcp ftplP 21 lanlP > 1024 * Allow
- out ethl tcp fwlP 22 adminlP > 1024 * Allow
- out ethl * * kKX * * kxR X * * Deny
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Example: Direction-Oriented Filtering

Prerequisite

The Firewall

Firewall

Configuration
Packet-Filter

> Firewall

Stateful Firewall

Application-Layer

Firewall

Proxy

Summary

Packets claiming to be sourced from the internal network
inbound but arriving on an external network interface are

considered to be spoofed and such packets should not be
permitted by the firewall [RFC3330, RFC1918|.

The attacker forges packets to reflect the source IP addresses
that are associated with internal systems so that a firewall (not
configured with direction-oriented filter controls) interprets these
packets as having originated within the internal network.

O No way to authenticate IPv4 packets.
O This type of attack typically forms part of a Denial of Service
Attack (DoS) on an internal network.
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Stateful Firewall

Prerequisite

A stateful firewall filters like the packet-filter, ....

The Firewall
Firewall
Configuration OSI model TCP/IP model Common Packet Attributes Filtered
Eﬁ(e:tve:l_lﬁlter Applicatifm Application Application Protocol Pattern Matching
> Stateful Firewall Presentation
Application-Layer Session TCPTCP/UDP TCP & UDP protocol,
E'rewa” Transport TCP & UDP ports, TCP Flags
S::::;ary Network IP, ICMP source & destination IP, ICMP Type
Data Link Data link source MAC address
Physical Physical
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Stateful

Firewall

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

A stateful firewall filters like the packet-filter, but also tracks the
state of previous network packets.

O State information might include protocol, IP addresses,
ports, TCP flags, sequence and acknowledge numbers.

O State information is recorded when a TCP connection or
UDP exchange is initiated.

O Subsequent packets are examined not only based on stateless
rule but also on the context of the ongoing connection.

State Table Entry | Description
Example TCP Packet State Information at Network and Transport Layer

Protocol Transport layer protocol name and number.
Time Time remaining before state information is removed.
TCP State State of TCP connection (TCP only).
IP Addresses Source and destination IP addresses.
Ports Source and destination ports.
Expected Expected source and destination IP addresses and ports reversed.
Connection State Connection-tracking state of the connection.

tcp 6 90 ESTABLISHED src=192.168.1.10 dst=192.168.2.3 sport=1060 dport=22 src=192.168.2.3
dst=192.168.1.10 sport=22 dport=1060 ASSURED
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Stateful Firewall

ereauisiie While UDP [rfc768] and ICMP [rfc792] are stateless protocols,
€ Iirewa

Firewall their connections can be tracked, albeit in a limited fashion.
Configuration

Packet-Fil .

Frowall 0 For example, a UDP header does not contain flags or

> Stateful Firewall - -
A_pp”;;gn_ngef sequence numbers and, therefore, the only state information
revel recorded is the protocol, IP addresses and ports.

roxy

Summary

Some stateful firewalls, for example Netfilter, can examine
limited application layer data for some well known protocols like
FTP in order to track related connections accross ports.
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Example: Simplfying Stateless Complexity

Prerequisite

The Firewall
Firewall

Configuration

Packet-Filter
Firewall

> Stateful Firewall
Application-Layer

Firewall
Proxy

Summary

Stateless Packet-filters can examine packet headers for TCP
flags settings.

In practice, TCP flag filtering tends to focus only on SYN and

ACK flags.

O Consider permitting HT TP traffic to a Web server while
filtering based on TCP flags.

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action

1 in eth0 tcp KRR X > 1024 weblP 80 syn Allow

2 out ethl tcp weblP 80 KRR K > 1024 syn, ack Allow
However, in reality its much more complicated than that ...
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Example: Simplfying Stateless Complexity

Prerequisite
The Firewall

Firewall
Configuration

Packet-Filter

Need to consider specifying additional rules involved in
completing the TCP 3-way-handshake.

Firewall Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
> Stateful Firewall 1 in ethO tcp ok kK > 1024 weblP 80 syn Allow
Application-Layer 2 out ethl tcp weblP 80 Rk K > 1024 syn, ack Allow
Firewall 3 in ethO tep KRR K > 1024 weblP 80 ack Allow
Proxy
Summary
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Example: Simplfying Stateless Complexity

Prerequisite
The Firewall
Firewall
Configuration

Need to consider additional rules for ongoing bi-directional
communications.

Packet-Filter Index Dir Iface | Proto Src IP Src Port Dst IP Dst Port Flag Action
Firewall 1 in eth0 tcp KRR X > 1024 weblP 80 syn Allow
[> Stateful Firewall 2 out ethl tep weblIP 80 KRk K > 1024 syn, ack Allow
Application-Layer 3 in eth0 tcp ¥F** | > 1024 | weblP 80 ack Allow
Firewall 4 in eth0 tcp KRR K > 1024 weblP 80 ack Allow
Proxy 5 out | ethl tcp weblP 80 * kK > 1024 ack Allow
Summary
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Example:

Simplfying Stateless Complexity

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Need to consider additional rules to permit either side of the

connection to terminate.

0 Client can initiate the closure (Rule 6).

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp KRR X > 1024 webIP 80 syn Allow
2 out ethl tcp weblP 80 Rk K > 1024 syn, ack Allow
3 in eth0 tcp * kR X > 1024 webIP 80 ack Allow
4 in eth0 tcp kR R x > 1024 weblP 80 ack Allow
5 out ethl tcp weblP 80 KRR K > 1024 ack Allow
6 in eth0 tcp kR R X > 1024 weblP 80 fin,ack Allow
7 out ethl tcp weblP 80 Rk K > 1024 fin,ack Allow
8 out ethl tcp weblP 80 * ok ok *x > 1024 fin,ack Allow
9 in eth0 tcp KOk R > 1024 weblP 80 fin Allow

Previously defined Rules 5 and 6 are also activated.
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Example:

Simplfying Stateless Complexity

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Need to consider additional rules to permit either side of the
connection to terminate.

0 The Web server itself can initiate the closure (Rule 8).

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp KRR X > 1024 webIP 80 syn Allow
2 out ethl tcp weblP 80 Rk K > 1024 syn, ack Allow
3 in eth0 tcp * kR X > 1024 webIP 80 ack Allow
4 in eth0 tcp kR R x > 1024 weblP 80 ack Allow
5 out ethl tcp weblP 80 KRR K > 1024 ack Allow
6 in eth0 tcp kKR x > 1024 weblP 80 fin,ack Allow
7 out ethl tcp weblP 80 Rk K > 1024 fin Allow
8 out ethl tcp weblP 80 KOk xR K > 1024 fin,ack Allow
9 in eth0 tcp KRR > 1024 weblP 80 fin,ack Allow

William Fitzgerald, CS6315, Feb. 2010.
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Example:

Simplfying Stateless Complexity

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Need to consider additional rules to permit either side of the
connection to terminate.

[0 Rules 10 and 11 allow either side to reset the connection.
Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp KRR > 1024 weblP 80 syn Allow
2 out ethl tcp weblP 80 KOk R K > 1024 syn, ack Allow
3 in eth0 tcp kKR x > 1024 weblP 80 ack Allow
4 in eth0 tcp kKX > 1024 webIP 80 ack Allow
5 out ethl tcp weblP 80 KRR K > 1024 ack Allow
6 in ethO tcp * Ok x ok > 1024 webl|P 80 fin,ack Allow
7 out ethl tcp webl|P 80 * ok ok *x > 1024 fin,ack Allow
8 out ethl tcp webIP 80 * Ok Kk > 1024 fin,ack,ack Allow
9 in eth0 tcp * ok x k > 1024 weblP 80 fin,ack Allow
10 in eth0 tcp kKR X > 1024 weblP 80 rst Allow
11 out ethl tcp weblIP 80 KKk K > 1024 rst Allow
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22 /31




Example:

Simplfying Stateless Complexity

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

A stateful firewall manages this complexity seemlessly.

The following stateless rules can be replaced stateful rules.

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port Flag Action
1 in eth0 tcp KRR X > 1024 webIP 80 syn Allow
2 out ethl tcp weblP 80 Rk K > 1024 syn, ack Allow
3 in eth0 tcp * kR X > 1024 webIP 80 ack Allow
4 in eth0 tcp kKR x > 1024 weblP 80 ack Allow
5 out ethl tcp weblP 80 KRR K > 1024 ack Allow
6 in eth0 tcp kKR x > 1024 weblP 80 fin,ack Allow
7 out ethl tcp weblP 80 Rk K > 1024 fin Allow
8 out ethl tcp weblP 80 * ok ok *x > 1024 fin,ack Allow
9 in eth0 tcp KOk R > 1024 weblP 80 fin Allow
10 in eth0 tcp * Ok kX > 1024 webIP 80 rst Allow
11 out ethl tcp weblP 80 Rk K > 1024 rst Allow

Note there are some redundant rules in the above rule-set, a subject of the next lecture.
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Example:

Simplfying Stateless Complexity

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

A stateful firewall manages this complexity seemlessly.

Index

Dir

Iface

Proto

Src IP

Src Port

Dst IP

Dst Port

State

Action

1

in

ethO

tcp

EIEIEIE]

> 1024

weblP

80

New, Est

Allow

2

out

ethl

tcp

weblP

80

* % % %

> 1024

Est

Allow
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Example: Stateful Port-based Attack Surface Reduction

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

Recall, the packet-filter's example of port-based attack surface
reduction where a the attack surface was reduced on the
server-side.

Need to also consider client-side port-based attack surface
reduction.

O Why?

O HTTP, for example, operates by creating a TCP connection
in which the TCP port number for the Web server is 80
(privileged port defined by IANA) and the TCP port number
for the client in the unprivileged port range (ports 1024 to
65535). Clients are dynamically assigned a port number from

a range of 1024 to 65535.

Client side port assignment only exist during the lifetime of the
TCP connection.
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Example: Stateful Port-based Attack Surface Reduction

iLerqu_“‘S‘te” 0  The (stateless) packet-filter must statically open ports for
€ rirewa
Firewall the entire unprivileged port range.
Configuration . . o . .
Packet-Filter 0 Totaling 64511 individual ports, resulting in unnecessary
Firewall
D> Stateful Firewall attack surface exposure.
Application-Layer
Firewall 65535
Proxy %
Summary q%
E
8
— % EC @ hitp
Y
é @ https
3 Web Server
2
<
1024 ok
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Example: Stateful Port-based Attack Surface Reduction

iLerqu_“‘S‘te” A stateful firewall has state information that allows for dynamic
€ rirewa

Firevall port opening on demand, resulting in an attack surface

ontiguration . .

Packet-Filter applicable only to the actual client and server ports only.

Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

src port 1909 —EZ €. @ http
@ https
Web Server

Stateless Packet-Filter Firewall
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Example: Port Scan Reduction

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

In comparison to stateful firewalls, stateless packet-filters are

more prone to port scanning attacks.

O The lack of authentication in typical network and transport
layers means that TCP packet header fields can be forged to

bypass stateless firewall rules.

O
£=
i
5
(O]
5 X
== @]
— pkt®=[srclP:hackerlP,dstIP:lanlIP,srcPort:80,tcp-flag: ACK] > DCE — Allow >
(]
9
S
n
Index | Dir | Proto | Src IP | Src Port | Dst IP | Dst Port | Flag | Action
4 in tcp | XRxK 80 lanlP | >1024 | ack | Allow
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Example: Port Scan Reduction

Plaregplele Attacks of this nature against a stateful firewall will fail.

The Firewall
Firewall
Configuration

Packet-Filter

Firewall state table.

> Stateful Firewall
Application-Layer

O A stateful firewall will consult both its rules and the current

Firewall
Proxy —
©
Summary 2
=
L
»g — pkt®=[srcIP:hackerlIP,dstIP:lanlP,srcPort:80,tcp-flag: ACK] > &8 — Deny >
=
S
1
(0]
Index | Dir | Proto | Src IP | Src Port | Dst IP | Dst Port State Action
4 in tep | ¥R F | <1024 | lanlP > 1024 | Established | Allow
State Table

No entry in the state table for an existing outward bound HTTP request,

sourced on some lanlP with a source port >1024,
bound for destination port 80 over TCP on host hackerlP
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Example: Port Scan Reduction

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

> Stateful Firewall
Application-Layer
Firewall

Proxy

Summary

While the construction of forged TCP packets that have the
TCP ACK flag set will not open a connection to a system behind
the firewall (stateless or stateful), it is a useful TCP ACK scan.

Using this type of network scan, it is possible to infer information
about the rules within a firewall configuration.

0 For example, if the firewall (or internal hosts) returns a TCP
RST packet, the attacker can determine that an internal host
exists; if not, it is assumed the port of the firewall is closed.
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Application-Layer Firewall

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall
Stateful Firewall
Application-Layer
> Firewall

Proxy

Summary

An application-layer firewall, while it can examine both network
and transport layer packet headers, can also examine a packets
payload at the application layer.

It provides increased assurance of the validity of packet content
and can make decisions based on. For example:

O Multimedia applications being tunneled over HTTP.
Access requests to restricted web sites.

Malicious content.

Information disclosure, proprietary information filtered with
keywords or regular expressions.

O O

William Fitzgerald, CS6315, Feb. 2010. 25 / 31



Example: Control Tunnel Bypass Attempts

Prerequisite

The Firewall

Firewall

Configuration

Packet-Filter

Firewall

Stateful Firewall
Application-Layer

> Firewall

Proxy

Summary

From the point of view of the firewall, the term tunneling refers
to the practice of encapsulating data from one protocol inside
another protocol in order to evade the firewall.

O For example, a Skype client typically listens on TCP and
UDP port 33033.

O However, should Skype fail to establish communication over
that port, it has the ability to operate on ports required by
HTTP (port 80) and HTTPS (port 443).

O Note, if Skype defaults to port 443 then a SSL scanner will
be required to inspect the data.
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Example: Control Tunnel Bypass Attempts

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall
Stateful Firewall
Application-Layer
> Firewall

Proxy

Summary

The previously defined stateful firewall rule (rule 8) that is
intended to mitigate the use of Skype is now ineffective.

Skype packets can traverse the stateful firewall unhindered
exploiting the intended purpose of the HTTP rules (rules 4 &

13).

Index Dir Iface Proto Src IP Src Port Dst IP Dst Port State Action
1 in eth0 tcp * Kk K > 1024 weblP 80 New,Est Allow
2 in eth0 tcp * ok ok *x > 1024 webl|P 443 New,Est Allow
3 in ethO tcp partnerlP > 1024 vpnlP 22 New,Est Allow
4 in eth0 tcp Rk K 80 lanlP > 1024 Est Allow
5 in ethl tcp lanIP > 1024 ftplP 21 New Allow
6 in ethl tcp lanlP > 1024 ftplP 21 Est,Rel Allow
7 in ethl tcp adminlP > 1024 fwlP 22 New,Est Allow
8 in eth0 udp * Kk K * lanlP 33033 New Deny
9 in ethO * KKk K * * Ok kX * * Log
10 out ethl tcp weblP 80 kKR X > 1024 Est Allow
11 out ethl tcp weblP 443 KRR > 1024 Est Allow
12 out ethl tcp vpnlP 22 partnerlP > 1024 Est Allow
13 out ethl tcp lanlP > 1024 KRR 80 New,Est Allow
14 out ethl tcp ftplP 21 lanlP > 1024 Est,Rel Allow
15 out ethl tcp fwlP 22 adminlP > 1024 Est Allow
16 3 * * * % o ¥ 3 * % % % * * Deny
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Example:

Control Tunnel Bypass Attempts

Prerequisite

The Firewall

Firewall

Configuration

Packet-Filter

Firewall

Stateful Firewall
Application-Layer

> Firewall

Proxy

Summary

Having the ability to inspect the data at the application layer for

Skype traffic is essential.

O An example of then many possible Skype signatures used in

a Skype-to-Skype communication, is given as:
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Example: Control Tunnel Bypass Attempts

Prerequisite
The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer

Application-layer firewalls typically provide a pre-built database
of known filter signatures.

O For example, Skype-to-Skype (UDP voice call between two
or more skype clients) and Skypeout (UDP voice call from

P Firewall Skype client to POTS phone).
Proxy
Summary
Index Dir Iface Src IP Dst IP Proto Src Port Dst Port L7-filter Action
- out ethl * Kk K lanlP udp 80 skypeout Deny
- out ethl Rk K lanlP udp 80 skyptoskype Deny
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Example: Granular Malware Control

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall
Stateful Firewall
Application-Layer
> Firewall

Proxy

Summary

Application-layer firewalls can be used to filter some kinds of
Malware.

For example, the Nimda worm made it possible for a Windows 1S
Web server to be exploited by allowing a client with a specially
formed request to break out of the Web server’'s document root
and begin executing arbitrary programs on the Web server.

Index Dir Iface Proto Src IP Dst IP Src Port Dst Port L7-filter Action
- in eth0 tcp KRR X webSrvIP * 80 nimda Deny

Note, inspecting layer-7 for Malware payloads has a performance
impact. More importantly, filter controls can often be subverted
using packet fragmentation for example.
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Proxy

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

> Proxy

Summary

A proxy is a system that acts as an intermediatory when
forwarding packets on behalf of a client system requesting access
to a network resource (server).

0 A client system establishes a TCP/IP connection with the
proxy system when it has a request that is to be forwarded to
a server.

0 The proxy in turn, contacts the remote server and establishes
a secondary TCP/IP connection where the proxy then relays
the ongoing communication between the client and server.

0 To the client, it appears that there is a direct TCP/IP
connection between itself and the server.

O Similarly, the server has no knowledge of the client and
communicates with the proxy as if it where the client.
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Proxy

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

> Proxy

Summary

Each successful connection attempt actually results in the
creation of two separate TCP connections, one between the
client and the proxy system, and another between the proxy
system and the destination server.

The proxy is transparent to the two end systems (client and
server), and from their perspective they are directly connected to
one another.

This provides an additional level of protection to the internal
systems because external client systems can only communicate
with the proxy and therefore internal IP addresses are not
publicly known to the external Internet.
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Application Proxy

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

> Proxy

Summary

An application proxy is a proxy that has application-layer firewall

capabilities.

Application proxies are systems that specialise in providing access

control for a single application protocol, for example, HT TP,
FTP or SMTP.
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Circuit-level Proxy

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

> Proxy

Summary

An circuit-level proxy is a proxy that has stateful firewall

capabilities. Circuit-level proxies such as SOCKS are concerned

only with IP addresses and port numbers.
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Summary

Prerequisite

The Firewall
Firewall
Configuration
Packet-Filter
Firewall

Stateful Firewall
Application-Layer
Firewall

Proxy

> Summary

Provided an overview regarding the:

[
[
[

Importance of firewalls in terms of network access control.

Firewall classifications: advantages and disadvantages.
Deep understanding of network protocols and firewall
capabilities is required to configure firewall correctly.
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